OrCAD Constraint Driven Design Flow
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Sr. Field Applications Engineer
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Customer promise...
Our focus today, as it was in 1989, is to meet our customers’ requirements

with quality products, leading technology, and exceptional technical
support.
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EMA Design Automation

* From point solutions to fully integrated EDA systems including
Cadence Design Solutions:

Cadence® Allegro® PCB Design Tools
Cadence® OrCAD® PCB Design Tools

- Complimentary technologies:
CircuitSpace - Component Placement and Design Reuse
TimingDesigner® - Timing analysis for digital design
CIP - Component Information Portal
Enterprise Link - CIS to PLM/MRP Synchronization
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Webinar Topics

Assigning Component and Net Properties in OrCAD Capture
Auto Assigning Differential Pairs in OrCAD Capture

Passing Properties from OrCAD Capture to PCB Editor
Placement of Components with ROOM Properties

Using Technology Files into PCB Editor

Anatomy of a Differential Pair

Routing Differential Pairs

Routing Nets with Total Etch Length Constraints

Constraint Resolution

Design Reuse

Demos
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Assigning Component Properties in
OrCAD Capture

» Component Properties
—ROOM - Floor planning

—HARD_LOCATION - Locks reference designator from being
modified by Auto Rename and back-annotation process

e

PCB Footprint SM_1209 SM_1206 SM_1208 SM_1206
PIN_ESCAPE

PINUSE
PLACE_TAG

POVWER_GROUP

Power Pins Visible r I r [
Primitive DEFAULT DEFAULET DEFAULT DEFAULET
RATED_MAX_TEMP
REFERENCE c? c19 c?
REUSE_INSTANCE

C15

Source Library CACADENCEWRSD 5.2 | PCACADENCEWSD 3.2 f CACADENCEVWRSD 3.2 | POCACARENCERSE 8.2

SWAP_GROUP
T_TEMPERATURE

T

OrCAD EMA 2o
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Assigning Net Properties In
OrCAD Capture

* Net Properties
—NET_PHYSICAL_TYPE - Creates a Net Class in Physical Domain
—NET_SPACING_TYPE - Creates a Net Class in Spacing Domain
—MIN_LINE_WIDTH - Physical Constraint override

MAX_XTALK
MIN_BOND_LENGTH

MIN HOLD
MIN_LINE_WIDTH
MIN_NECK_WIDTH

GND_EARTH

NET_PHYSICAL_TYPE CLOCK_PH

NET_SCHEDULE

NET SPACING TYPE DC_NETS CLOCK
NO_GLOSS

NO PIN ESCAPE
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Assigning Net Properties In
OrCAD Capture

* Net Properties

— ROUTE_PRIORITY - Instruction for the Autorouter to prioritize net

— TOTAL_ETCH_LENGTH - Controls the maximum length of the
overall net

PULSE_PARAM

RATSHEST_SCHEDULE

ROUTE_PRIORITY
1N

SHIELD_TYPE
STUB_LENGTH
SUBHET_NAME

] L} [ ] J L

TOTAL ETCH LENGTH ZI00MIL:Z2400MIL Z300MIL:2400MIL ZI00MIL:Z2400MIL ZI00MIL:2400MIL
TS_ALLOWED
VOLTAGE
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Differential Pairs:
Auto Assign in OrCAD Capture

 Signal Naming Convention for Auto Setup of Differential Pairs
Examples:

SignalName_ P SignalNameP
SignalName_N SignalNameN
SignalName_H SignalNameH
SignalName L SignalNamelL
SignalName_+ SignalName+
SignalName_ - SignalName-
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Differential Pairs

Auto Setup in OrCAD Capture

Tools > Create Differential Pair > Auto Setup

Prefiu :

- Filker :

P +Filter: P M

——
Ditr Pair M ame

+Met Met
DP_SIGMALMAMET SIGNALNAMET_P  SIGNALMAME1_N
DP_SIGMALMAMEZ SIGNALNAMEZ_ P SIGMALMAMEZ_M
DP_SIGMALMAMER SIGNALNAMEZ P SIGNALMAMEI_N

OrCAD Capture CI5 - o
[ File Design Edit View [N Place SlAnalysis Macro Accessories Reports Options Window Help TeamDesig
H - o WE Annotate... =
e a Sl Anno BE
a = 44 Back Annotate... uz @ D IE [
E Update Properties... E & ﬁ % % E‘!‘ =
: Test Bench 4 T
[ cP ][ StartPace|  partManager » ﬂ PAGE2 ][E H1 ]@ H2 ]
=2 Design Rules Check... I
- = " F -
-0 Deslgn Resources | Create Differential Pair...
& C Ref
ross FEerence [Net v] Diff Pair N ame:
InterSheet References...
Bill of Materials... 2 .
P &l Nets Diff Pait Selzalane:
rt rties... . .
Sniielis I_Es Ry et Name Diitf Pair Create
Import Properties...
COM1 -
Generate Part... CONZ . I odif
! ) Export FPGA... COmMa Differential Pair Automatic Setup
B3 Amynewlib, b0 CON4 -
-0 Outputs Assign Power Pins... oli] All Nets :
...... £ Referenced Projects D1
#--E0 TestBenches S : . -
Sync NetGroup... o2 ik All Mets Lvitf Pair Sl
Customize... < | Ll | v 2 =
i i CON1
Board Simulation.. Fiker - Bt Setup. e
COM3
CONg
i1}
D1
D2 -
< T | »
Filker :

OrCAD
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Other Differential Pair Properties

« Set constraint overrides for Differential Pairs
— DIFF_MIN_SPACE - Minimum Spacing
— DIFF_UNCOUPLED_LENGTH - Maximum Uncoupled Length

A B C D E F
SIGNALNAMET_N SIGNALNAMET_P SIGNALNAMEZ_N SIGNALNAMEZ_P SIGNALNAMEZ_N SIGNALNAME3_P
BUS_NAME
CLK_20UT_MAX

CLK_20UT_MIN
CLK_SKEW_MAX
CLK_SKEW_MIN

ECL_TEMP

ELECTRICAL_CONSTRAINT_SET
FRAC COITHC AL MFT

EMA 3
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Passing Properties from OrCAD Capture to

PCB Editor

Tools > Create Netlist

m OrCAD Capture CIS - [\

Edit View |

Accessories

Reports  Optior

& @

' |

[ File Design Tools Place SI Analysis  Macro
E l,_]_ E = U? Anngtate...

g 44 Back Annotate...

E Update Properties...

: Test Bench 4
[ CIP H Start Page Part Manager 3

=2 Design Rules Check...

i

£ Fie |8, Hierarchy| [E Create Netlist..
=0 Design Resources Create Differential Pair...

=5 [# Cross Reference...

Release Rooj InterSheet References...
B Pagel | @ Bill of Materials...
E Pagel .
El £9 DAAMP Circ Export Properties...
E D/A AM Import Properties...
El CI Data Schem Generate Part...
[ DataPy  ppon FRGA..
El Iil HSRAM
. E High Sp Assign Power Pins...
Ic:l Design Cach
...... £ Library

Sync NetGroup...

Customize...

= = Qutputs

------ pstxnet.dat
- pstxprt.dat
- pstchip.dat

Beard Simulation..

OrCAD
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PCB Editor |EDIF200 [ INF | Layout | PSpice | SPICE | Verlog | VHDL | Other |

FCE Foatprint
Combined property string:
FCE Foatprint

alleqra E]

Create PCE Editor Metlist
Options
Metlist Files Directary:
[ Wi Dot

Create or Update PCE Editor Board [Metrey)

Options

Input B oard File: ConstraintDrivenFlowiDemoshDatabazehallegrobDemaStart brd E]

Output Board File: 1 4\CongtraintDiivenFlowsDemosiD atabazeallegrotD emol brc E]

[ &llows Etch Removal During ECO [ llows U zer Defined Property

[ lanore Fized Property

Place Changed Components: @ Always () 1FSame () Newer
Board Launching Option
@) Open Board in Allegro PCE Editor

") Open Board in Cadence SiP

") Open Board in AFD
(7) Open Board in 0rCAD PCE Editor

[Thiz option will not transfer any

() Do nat open board file high-speed properties to the board)

ok [ Cancel |[ Hep |

Design
Automatlon



Passing Properties from OrCAD Capture to

.
_| allegro.cig - Notepad Elﬁﬂ

PCB Editor

- Edit allegro.

cfg file

S

PCB Editor |EDIF200 [ INF | Layout | PSpice | SPICE | Verlog | VHDL | Other |

FCE Foatprint
Combined property string:
FCE Foatprint

Create PCE E ditar Metlist

Options
Netlist Files Directaong: allsgro
[ Wiew Output

Create or Update PCE Editor Board [Metrev]
Options
Iriput Board Fils: CanztraintDrivenFlowiD er|
Output Board File: 14\ CanzstraintD ivenFlows]

Setup

[7] &llow Etch Removal Duing ECO (] Allow
[ lanore Fized Property
Place Changed Components: @ Always

Board Launching Option
@) Open Board in Allegro PCE Editor

() Open Board in Cadence SiP

() Do ot open board file

OrCAD

CADENCE PCB SOLUTIONS

Cfg Canfig

Configuration File:

SPB_16.E\toolz/capture/allegro.cfg -

Backup Yersions: 3 =
Mizcelaneous
Device/Met/Pin = .
Wame Char Limit Dutput 4/ arrings
Suppress Warnings:
[ 1anore Electical constraints A
ak. ] [ Cancel ] [ Help

-

File Edit Format View Help

[ComponentInstanceProps]
GROUP=YES
HARD_LOCATION=YES
ROOM=YES

VOLTAGE=YES
CDS_FSP_LIB_PART_MODEL=YES
CDS_FSP_IS_FPGA=YES
CDS_FSP_INSTANCE_NAME=YES
CDS_FSP_INSTANCE_ID=YES
SIGNAL_MODEL=YES
NO_XNET_CONNECTION=YES

[netprops]

BUS_NAME=YES
CLOCK_NET=YES
DIFFERENTIAL_PAIR=YES
DIFFP_MIN_SPACE=YES
DIFFP_PHASE_TOL=YES
DIFFP_GATHER_CONTROL=YES
DIFFP_UNCOUPLED_LENGTH=YES
DIFFP_Z2ND_LENGTH=YES
DIFFP_LENGTH_TOL=YES
ECL=YES

ECL_TEMP=YES
ELECTRICAL_CONSTRAINT_SET=YES
EMC_CRITICAL_NET=YES
IMPEDANCE_RULE=YES
MATCHED_DELAY=YES
MAX_EXPOSED_LENGTH=YES
MAX_FINAL_SETTLE=YES
MAX_OVERSHOOT=YES
MAX_VIA_COUNT=YES
MIN_BOND_LENGTH=YES
MIN_HOLD=YES
MIN_LINE_WIDTH=YES
MIN_NECK_WIDTH=YES
MIN_NOISE_MARGIN=YES
MIN_SETUP=YES
NET_PHYSICAL_TYPE=YES
NET_SPACING_TYPE=YES
NET_SHORT=YES
NO_GLOSS=YES
NO_PIN_ESCAPE=YES
NO_RAT=YES

NO_RIPUP=YES
NO_ROUTE=YES

NO_TEST=YES
PROBE_NUMBER=YES
PROPAGATION_DELAY=YES
RELATIVE_PROPAGATION_DELAY=YES
RATSNEST_SCHEDULE=YES

4
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Placing Components with ROOM Properties

Place > Manually > Room

}xbr(.‘AD PCB Designer ssional: Pa

Eile Edit View Add Display Setup Shape Logic Place Route Manufacture Tools CircuitSpace Help (é de nce
CE o5 - : -~ T O 3 123 =]
iLg ) :"%}" L X 9 4 @ # i @ 8 & Q s & : fE g = E B UEQF_"I @k X N
: — ¢ : 3 s o q_ = B oo VR,V Xy = 1 =
i @ @ B = ) A= | |"i — Bl &0 dE v BBED £l B =
. Placement o o =
_ : -
Placement List | Advanced Seltings | =
=
v = ’—Componenls b refdes - ?‘BI:ACILOT"E'S ‘7 -
atc} =
G g 3 Comporints by eids a
i 1§ M " Property: J
D2
i o Value
D4 (= Room [Led ]
Ay Al I e
» R et [ J
R4 o O
3 Hs " Schematic page number
!  Place by refdes
auas Cuickview
|
ol | :
| Mo preview
abc |
(4] i
o il
= I [ [ + Graphics " Teut
= 4
Hide Cancel Help
&4
&
| [last pick: 1950.00 2350.00 RIS = |
4 |last pick: 1950.00 2400.00 4
1 |Selest elements to place using ties view 3
3 |Select elements to place using tree view. =
£ |Selext slements to placs using ties view. I
S |Cammand > ~||=
|place manual I | Scldemask_Top 4550.00, 315000 [PJ[A]l - [rull) | | General edi | on I ¢
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Placing Components with ROOM Properties

Place > Quickplace > Room

3 OrCAD PCB Designer Prafessional: PartialPlace.brd Project Cr-/Demos/Database/alleg

=il |
File Edit View Add Display Setup Shape Logic Place Route Anal Manufacture  Tools CircuitSpace  Help [ B Quickplace l:, | |—’h‘| cadence
e e
: et o = S @ @ o] am MR 3 —
== @+ FHEAS]QQEOME U e
@ [ O = é H = R iz @& " Place by property/value [ -] =l
@ Place by room 4l Rooms =l |+ Options v x|
" Place by part number All Rooms
Chan2 '_‘ Active Class and Subclass: -
" Flace by net name Chani 2 g =
e . . Board Geometry - =
(=] A
Place by schematic page number - Ty =
€ Place all components [FEEX iz =
i € Place by refdes
o Place by REFDES
Type I [ I
L Refdes (8 [
. e |
Mumber of pirs: Min: |—l'| May: rﬂ
»
= Placement Posiion
= ]
N c | Sekecton |
= {
Edge Board Layer
-
[z - [ TOP =l
[~ Overap companents by 50 %
Svmbols placed: 0 of 36
-
Unplaced symbal count: 57 Viewlog.
| QK Place Unplace Cancel ‘ Help
' [Select lemerts to place using tree view. l —
4 |last pick: -1600.00 3650.00
2 Mo element found. Iz
% |Performing autosave. 1=
E | ful 3
E Autosave successiul |5
S |Command > ~| =
[quickplace | [~ Both_Rooms [ z205000.3600.00  [P[A]] -] [ [ General edit [ o I °
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Using Technology Files

— Parameters

— Design-level constraint data
— Constraint Modes

— Cross-section

— User-defined propertieS
Stored on disk

databases
Results reported in techfile.log

ccccccccccccccccc

Technology files (tech files) contain:

Preserve company standards while creating new
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Using Technology Files - Export

File > Export > Techfile...

ech File O

Output tech file:

|1 0 Laper Highzpesd

Wiewlog...

E =paort | Cloge Help

O I’C A D EMA ‘In\fl%n':atmn
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Using Technology Files - Import

File > Import > Techfile...

ccccccccccccccccc

ech file

Input tech file:

|rk|i|:u.-’u:ran|:uerr_l,l_'| /physical/10_Laver Highspeed.tcf]

v Run DRC and update shapes

Irnpart

Close

Librany...

WYiewlog... |

Help

Design
Automatlon



Anatomy of a Differential Pair
Minimum Line Width

* The trace width that should be used to route the differential pair
nets the majority of the time

« The width you prefer your differential pairs to be routed

Min Line Width

O FC A D EMA ‘?\ﬁi:ml?latmn
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Anatomy of a Differential Pair
Primary Gap

« The Spacing, edge to edge, that should be used to route the
differential pair nets the majority of the time

* The rule you prefer your differential pairs to follow

« This only applies to the two differential pair nets. Other net
spacing to the differential pair nets is controlled by the Spacing
Rule set Line to Line clearance

Primary Gap =‘ i:

O FC A D EMA ‘Rﬁihlrlatmn“
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Anatomy of a Differential Pair
Neck Width and Neck Gap

* Rules to be applied when the traces must “squeeze” down to
be routed between pins/vias (for example, in BGA areas)

* Neck Gap is the new spacing, edge to edge, that should be

routed to route the differential pair

 Neck Width is the new trace width that should be used to route

the differential pairs

—— Neck Width

v

Neck Gap

ccccccccccccccccc
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Anatomy of a Differential Pair
Separation Gap Tolerance

« Coupled Tolerance (+)/(-)
— Provides a coupling range based on the Primary Separation Gap

— Summing Primary Separation Gap and Coupled Tolerance (+)
provides the maximum coupled gap

— Subtracting Primary Separation Gap and Coupled Tolerance (-)
provides the minimum coupled gap

— Values above or below these become an uncoupling event

Primary Separation plus Primary Separation
(+) Tolerance minus (-) Tolerance
| f

_/:TT

Primary Separation Gap
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Anatomy of a Differential Pair
Minimum Line Space

* For the differential pair itself

 If set, this value must be less than your Primary Gap minus the
Coupled Tolerance Minus value

« Use this value to override the Spacing Constraint set line-to-
line value

Min Line Spacing —

O 09
o 009

O I’C A D EMA ‘In\fl%n':atmn
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Anatomy of a Differential Pair
Max Uncoupled Length

« Maximum length of uncoupled trace summed throughout the
entire differential pair route

« See green etch below:

[ Gathered
Z Ungathered

O I’C A D EMA ‘In\fl%n':atmn
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Anatomy of a Differential Pair
Gather Control

* Choices are Include & Ignore

« Controls whether or not to include the etch length from pin to
gather point when calculating Max uncoupled length

This length is Include OR
ALWAYS Ignore this total
Included length

Gather points

O I’C A D EMA ‘?\ﬁ%l:llatmn“
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Anatomy of a Differential Pair
Static Phase Tolerance

« Allowable difference in length between the differential pair nets

 When the Phase Tolerance Value is -1 (unspecified), phase
checking is disabled

/ Length of net A
\ Length of net B

Note: Available only in Allegro PCB Designer and above.

O FC A D EMA ‘Rﬁ?:ml:atmn“
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Differential Pairs
Physical Constraints

Differential Pair Constraints set in the Physical Domain

cadence - 7 X
| = 5 1<p i
e A A A
= Worksheet selactor p— i l
& Electrical _ _ = . _ _
5 Line Width Neck Length Static Differential Pair b
L Physical ] s Min Max Min Width | Max Length Max Phase N win Line Spacing | Primary Gep | Weck Gap | (+)Tolerance | (JTolerance | |
= = = ~ = = = Gather Control = = - = — =
EB Physical Constraint Set Type | HName mil mil mil mil mil mil mil mil mil mil
LB AllLayers . . s —— - . - o
& Net DPr [ DP_E_FC_TKCCLK 6.00:4.00:4.00. [ 0.00 3.00 10000.00 lgnore 600.00 5 mi 3.00 5.00:4.00:4.00.| 4.00 1.00 1.00
LB AllLeyers DPr [l DP E FC_TKCFC 6.00:4.00:4.00. [ 0.00 3.00 10000.00 lgnore 500.00 5 mi 3.00 5.00:4.00:4.00. [ 4.00 1.00 1.00
& i Region DPr [ DP_E_FC_TKCPAR 6.00:4.00:4.00._[ 0.00 3.00 10000.00 lgnore 500.00 5 mi 3.00 5.00:4.00:4.00. [ 4.00 1.00 1.00
LB AllLayers Py [l DP_E_FC_TKCSOF F00:4 00400 | 00D 300 10000 00 lgnore 500 00 5 mi 300 BO04 00400 | 400 100 100
DPr [l DP_E_FC_TKCSRB FO04 00400 | 00D 300 10000 00 lgnore 600 00 5 mi 300 BO04 00400 | 400 100 100
DPr [l DP_E_S4 RCLK 6.00:4.00:4.00. [ 0.00 3.00 10000.00 lgnore 600.00 5 mi 3.00 5.00:4.00:4.00. | 4.00 1.00 1.00
DPr [ DP_E_S4 RCTL 004, Jooo 3.00 10000.00 lgnore 600.00 5 mi 3.00 B.00:4.0 400 1.00 1.00
DPr [[] DP E 54 RPAR 5.00:4.004.00..| 0.00 3.00 10000.00 lgnore 500.00 5 mi 3.00 5.00:4.00:4.00. [ 4.00 1.00 1.00
DPr E DP_E_S4 RPROT 6.00:4.00:4.00._[ 0.00 3.00 10000.00 lgnore 500.00 5 mi 3.00 5.00:4.00:4.00. [ 4.00 1.00 1.00
DPr [ DP_I_FC_RXCCLK FO04 00400 | 00D 300 10000 00 lgnore 600 00 5 mi 300 BO04 00400 | 400 100 100
DPr [ DP_I_FC_RXCFC 6.00:4.00:4.00. [ 0.00 3.00 10000.00 lgnore 600.00 5 mi 3.00 5.00:4.00:4.00. | 4.00 1.00 1.00
DPr [ DP_I_FC_RXCPAR 6.00:4.00:4.00._[ 0.00 3.00 10000.00 lgnore 600.00 5 mi 3.00 5.00:4.00:4.00.| 4.00 1.00 1.00
DPr [l DP I FC_RKCSOF 6.00:4.00:4.00. [ 0.00 3.00 10000.00 lgnore 500.00 5 mi 3.00 5.00:4.00:4.00. [ 4.00 1.00 1.00
DPr [ DP_I_FC_RKCSRB 6.00:4.00:4.00._[ 0.00 3.00 10000.00 lgnore 500.00 5 mi 3.00 5.00:4.00:4.00. [ 4.00 1.00 1.00
DPr [ DP_I_FC_TXCFC FO04 00400 | 00D 300 10000 00 lgnore 600 00 5 mi 300 BO04 00400 | 400 100 100
DPr [ DP_I_SPI4_RCLK 6.00:4.00:4.00. [ 0.00 3.00 10000.00 lgnore 600.00 5 mi 3.00 5.00:4.00:4.00. | 4.00 1.00 1.00
DPr [ DP_I_SPM_RCTL 6.00:4.00:4.00._[ 0.00 3.00 10000.00 lgnore 600.00 5 mi 3.00 5.00:4.00:4.00.| 4.00 1.00 1.00
DPr [[] DP I SPi4_RAPAR 6.00:4.00:4.00. [ 0.00 3.00 10000.00 lgnore 500.00 5 mi 3.00 5.00:4.00:4.00. [ 4.00 1.00 1.00
DPr [ DP_I_SPI4_RPROT 6.00:4.00:4.00._[ 0.00 3.00 10000.00 lgnore 500.00 5 mi 3.00 5.00:4.00:4.00. [ 4.00 1.00 1.00
DPr [ DP_I_SPI4_RXDATO 6.00:4.00:4.00._[ 0.00 3.00 10000.00 lgnore 500.00 5 mi 3.00 5.00:4.00:4.00. | 4.00 1.00 1.00
DPr [ DP_I_5PI4_RXDAT1 FO04 00400 | 00D 300 10000 00 lgnore 600 00 5 mi 300 BO04 00400 | 400 100 100
DPr [l DP_I_SPI4_RXDATZ 6.00:4.00:4.00. [ 0.00 3.00 10000.00 lgnore 600.00 5 mi 3.00 5.00:4.00:4.00. | 4.00 1.00 1.00
%] Spacing DPr [ DP_I_SPM4_RXDAT3 6.00:4.00:4.00._[ 0.00 3.00 10000.00 lgnore 600.00 5 mi 3.00 5.00:4.00:4.00.| 4.00 1.00 1.00
[E  Same NetSpacing DPr [l DP_I_SPl4_RXDAT4 6.00:4.00:4.00. [ 0.00 3.00 10000.00 lgnore 500.00 5 mi 3.00 5.00:4.00:4.00. [ 4.00 1.00 1.00 =
) Properties [T+ I\ Al Layers / KR |
M DHE [ | | DRC | sync [ xneT

rCAD EMA 25imation
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Differential Pairs
Electrical Constraints

Differential Pair Constraints set in the Electrical Domain

@’; Allegro Constraint Manager (connected to Allegro PCB Designer (was Performance L) 16.6) [1_Censtraints] - [Electrical: Nets: Routing [1_Censtraints] ]

File Edit Objects Column View Apalyze Audit Tools Window Help (idence -8 X
PRI SRR L N — N E A S I R %% %hTa e,
= Worksheet selector L Tx 10 R I
Electrical | — - — -
_ n . Uncoupled Length Static Phase Min Line C P ters :l
E45 Hectrical Constraint Set Objects Gather | Length lgnore] Max | Actual - netant | marai |_SP2¢a [ Prim. Gap] Prim. Width] Neck Gap | Neck Wigth| (+)Tol. | (JTol.
-I& Routing Type | Name Control mil mil = i U3 o mil mil mil mil mil mil mil
25 Net N n ¥ ¥ ¥ ¥ N N N N N N
B- IE Routing DPr DP_E_FC_TXCCLK lgnore 500.00 3.00 8.00:4.00..| 6.00.4.00:4.| 4.00 3.00 100 1.00
Wiring DPr DP_E_FC_TKCFC lgnore 500.00 3.00 5.00:4.00..| 6.00.4.00:4._| 4.00 3.00 100 1.00
Vias DPr DP_E_FC_TKCPAR lgnore 600.00 3.00 5.00:4.00. | 6.004.004._| 4.00 3.00 100 1.00
Impedance DPT DP_E_FC_TXC50F lnore 600.00 3.00 _|6004004 200 3.00 100 1.00
Min/Max Propagation | | 2PT DP_E_FC_TACSRB lnore 600.00 3.00 6004004 200 300 100 1.00
DPr DP_E_S4_RCLK lnore 600.00 3.00 6004004 400 300 100 1.00
Total Etch Length
- - DPr DP_E_S4_RCTL lnore 600.00 3.00 6004004400 3.00 1.00 1.00
DilfEentialEan DPr DP_E_S4_RPAR lonore 500.00 3.00 6.00:4.00:4...| 4.00 3.00 1.00 1.00
Relative Propagation D| I'npr DP_E_S4_RPROT lgnore 500.00 3.00 [6.00:4.004.. [ 4.00 3.00 1.00 1.00
DPr DP_I_FC_RKCCLK lgnore 500.00 3.00 B.00:4.00. | 6004004 _|4.00 3.00 100 1.00
DPr DP_I_FC_RXCFC lgnore 500.00 3.00 8.00:4.00..| 6.00.4.00:4._| 4.00 3.00 100 1.00
DPr DP_I_FC_RKCPAR lgnore 500.00 3.00 -] 6002004400 3.00 100 1.00
DPr DP_I_FC_RKCSOF lonore 600.00 3.00 .| 6002004400 3.00 100 1.00
DPT DP_I_FC_RKCSRB lnore 600.00 3.00 6.00:4.00:4.. | 4.00 3.00 100 1.00
DPT DP_I_FC_TKCFC lnore 600.00 3.00 _|6002004 [200 300 100 1.00
DPr DP_I_SPI4_RCLK lnore 600.00 3.00 .| 6002004400 300 100 1.00
DPr DP_I_SPI4_RCTL lnore 600.00 3.00 .| 6002004400 300 100 1.00
DPr DP_I_SPI4_RPAR lnore 600.00 3.00 .| 6.00:4.00:4..[4.00 3.00 1.00 1.00
DPr DP_I_SPl4_RPROT lnore 600.00 3.00 | 6.00:4.00:4._[4.00 3.00 1.00 1.00
‘| | v [oer DP_I_SPI4_RXDATO lgnore 500.00 3.00 B.00:4.00. | 6004004 _|4.00 3.00 100 1.00
+IF Prysical —| [oer DP_I_SPI4_RXDAT1 lgnore 500.00 3.00 8.00:4.00..| 6.00.4.00:4._| 4.00 3.00 100 1.00
DPr DP_I_SPI4_RXDAT2 lgnore 500.00 3.00 5.00:4.00..| 6.00.4.00:4._| 4.00 3.00 100 1.00
l.¢ Spacing DPr DP_I_SPI4_RXDAT3 lgnore 500.00 3.00 8.00:4.00:...| 6.00:4.00:4...| 4.00 3.00 1.00 1.00
E  Same NetSpacing DPr ] DP_I_SPI4_RXDAT4 lgnore 600.00 3.00 5.00:4.00. | 6.004.004._| 4.00 3.00 100 1.00 .
= Properties q | » | iri i Impedance A Min/Max Propagation Delays A Total Etch Length A Differential Pair 3
Ll DRC Click and drag to change column size DRC | SYNC | XNET 2

OrCAD EMA 255 ation
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Constraint Regions

» Constraint Regions are Shapes with associated Physical

and Spacing Constraints

File Edit Objects Column View Apalyze Audit Tools Window Help

= B @ i < [ls fle
orksheet selector L T
Electrical ‘

DemoStart |

Physical I Objects Re

Line Width

Max Min Width

Max Length

i i Physical CSet
SR Physical Constraint Set Name ysical

mil

mil mil

mil

1B All Layers * *

EHv_; Net [F] DemoStart DEFAULT

]

1B All Layers BGA BGA_REGION

0

== Region

B Yo

Spacing
Same Net Spacing

Properties

[« [+ ]\ All Layers f

DRC

source: Region BGA

@/; Allegro Constraint Manager (connected to OrCAD PCB Designer Professional 16.6) [DemoStart] - [Spacing: Regions: All Layers [DemoStart] ]

DRC

. A

[ St

E = File Edit Objects Column View Analyze Audit Tools Window Help cidence -8 X
e iy H =7 w7 % i
=" @ % = s [Je o e e @ P E
= Worksheet selector L T X — 1
% Electrical -
- Obiects o Line To o
A Physical . Caat|__Line | Thru Pin| SMD Pin| Test Pin| Thru Via| BB Via | TestVia| Shape | Bond Finger| Hale
HLG’ Spacing Type | Name mil mil mil mil mil mil mil mil mil mil
5 Region = [F s T s s s s T s T s T 0
BB All Layers Dsn | |5 DemoStart DEFAULT 5 5 5 5 5 5 5 5 5 5
=] Rgn | BGA BGA_REGION |4 4 4 4 4 4 4 4
E Pins
B Vias
B Shape J
B Bond Finger
B Hole o
= Same Net Spacing =
i 4 ine ins ias ape ond Finger ole ia Gap 4 »
= Properies Li P Vi sh Bond Fi Hole 4 BB Via G
Lo DRC Minimum thru pin to line spacing (LINE_TO_THRUPIN_SPACING) DRC | SYNC

OrCAD
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Constraint Regions
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Differential Pairs
Routing Options

TR ree= () Eoe Route > Connect Horizontal
R adius: |'I:-c widthﬂ |Fi:.;e.;| ﬂ

Add vi
' = MNext Pattern
YWia Pattern 4
Change Active Laver k i ] Horizonkal
Change Alternate Layer V| gy . .
=& \ertical Vertical
=2Liagonal Up
Linelock:  [Line ] [30 = & Diagonal Down
Spacing...

Diagonal Up

a =100 x|
Lire lock: Like = 45 = Line lack: Line = 45 - Spacing Mode: utt| ﬂ
kiter: |1:-: widthﬂ |Min ﬂ kiter: |1:-: widthﬂ |Fi:-:ed ﬂ e inimum :

] | Cancel | Help | Dlagonal Down
I

Uzer Defined

EMA ‘Rﬁi:nlr]latmn*



Differential Pairs
Routing Options

* Once seeded, it is possible to route tandem differential
pairs as well as edge coupled.

FDGE COUPLED DP

O I’C A D EMA ‘Rﬁi:n?latmn
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Working with Differential Pairs

» Max Uncoupled Length constraint violation Marker = DU

* Pseudo-segments graphically show uncoupling errors in the
board

— Once the length of uncoupled etch exceeds the set value, every
segment that is uncoupled is highlighted in this way

RX_DAT3_P

RX_DAT3 N

O FC A D EMA ‘R‘lﬁ:naatmn“
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Routing Nets with Total Etch Length Constraints

* May be assigned to a Net, Xnet, Bus or Differential Pair

- Both Min and Max are etch length values with optional units
* If no units are specified, drawing units are assumed

« Either value is optional — May specify only Min, or only Max

§§F| Edit Objects Column View Apalyze Audit Tools Window Help cadence - & X
: : <7 W W 7 W i
H= @ﬂi’fl =l [le [Je .% T % .ﬁ B % W W Ve w6
= Worksheet selector L TXx Rdy2R e_XLI
|{§ EESE Total Etch Length Total Etch Length Unrouted Het | Routed/Manhattan ;l
lTj b Electrical Constraint Set < =k Enle‘j:‘lerz:lo(?:et Min | Actual | Margin| Max | Actual | Margin Length Ratio
E‘ JE Routing Type I §| Name mil mil mil mil mil mil mil Y
. B Total Etch Length * * 3 * * * * x * *
...E Differential Pair Net DO ECSETZ 2300
=5 Net —| | Net D1 ECSET2 2300 ]
18 Routing Net D2 ECSET2 2300
..... B Total Etch Length || [Met D3 ECSET2 2300
£ Physical Net 4 ECSET2 2300
— Net D5 ECSET2 2300
Lo e Net D& ECSET2 2300
&= Same Net Spacing Net 07 ECSET2 2300 IL'
=) Properties « [ v |4 Total Etch Length £ Differential Pair / I
b DRC [source: : Net D5 (read only) PASS ['Analyze' to view results) PBREN | sYNC | XNET 4

EMA ‘ln\?l%n':atmn“



Routing Nets with Total Etch Length Constraints:
Delay Tune

« Use the Delay Tune function to add length
* May also be used to match the length of a group of nets

O I’C A D EMA ‘Rﬁi:nit]latmn
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Constraint Resolution
Physical

C

[ ) Top diSplayS element & show Constraints ol

. ) SREEA

I n fo rm atl O n Constraint Hierarchy

- D e S C ri pti O n | |F1@‘11‘l!?‘11t 1 |Flement i
Deseription “ertical Line Segment "Ra3,

—_ i ' Etch/Top"

X/Y location Location (210000 2575.00) |

— Net name |NetC‘lﬂss | |
|Bus | |
DiffPair | |
XINet | |
Net RA3 |
[PinPair | |
|NetC‘lﬂss—Net{‘lﬂ ss | |
|Reg'un | |

Segment width = £.00 mils. Segment length = 300,00 mils.

Resolved Physical Constraints

* Bottom displays
constraint rules Resobved

Source Name Constraint Value

— Constraint set name M MIULDE WIDTH Mo Lanc Wi |3 MIL

Design  |DEFAULT Minimum Neck Width |6 MIL
— Constraint set rules Design  |DEFAULT Masimum Neck Length [0 MIL
Design  |DEFAULT Meazirmum Line Width [0 MIL

— Constraint values

CADENCE PCB SOLUTIONS

Display > Constraint
Single select

EMA 2555 ation



Constraint Resolution
Spacing

* Top displays element

Show Constraints ] 5]
— I I = X é ? Search: | [T Matchword [T Match case D rag S e | eCt
escription (] .
H Constraint Hierarchy L
X/Y |Ocat|0 n | |Flement 1 |Flement 2
— N et n a m e |De-sc1‘i11tiun |Vertical Line Segment "Ea3, Etch/Top" |Connect Pin "TT10.30"
Location 2100.00 2575.00 212500 262500
| (2100.002575.00) (2125.00 2625.00)
|Ne-t(_'l:|ss | |
|Bus | |
DiffPair | | |
XNet | | |
|
Net RA3 RAS R
. PinPair | | |
¢ BOttom d ISpIayS |Ne-tC‘lﬂss—Net(_'lﬂss| | ]
. Redi
constraint rules Region | | g
—_ CO N Strai nt Set Air gap distance between elements = 10.00 tmils :
Resolved Spacing Constraints [
name
|Res-:-lve d Level |S-:-1u‘ce Name |C‘unsu‘ﬂi.nt |\-"alue |
— Constraint set Design DEFAULT  [Line to SMD Pin Spacing |3 MIL -
|
rules -

— Constraint values

O FC A D EMA ‘?\ﬁi:ml?latmn

CADENCE PCB SOLUTIONS



Design Reuse
Placement Replication

Avallable in Placement Application Mode only
Allows creation of seed circuits
* May be replicated

— Within the current design
— From one design to another

May include:

— Component Placement

— Related Routing

— Local Shapes

— Reference Designator Placement

ccccccccccccccccc
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Design Reuse

Placement

Replication

LI ks

¢ el-oeceee

MJE’
L

-
I FEEE NS NNENNDN
I E R EERENENENRENDE

Add to group
Show Rats
Blank Rats
Assign color
Highlighk

Fix

Unfix
Propetty edit
Show element
30 Miew

Inplace component
Place replicate create
Place replicate apply ~ #
-
=

Application Mods
Supet filker

ccccccccccccccccc

Step 1 and 2

Create original circuit
and select components

LI i

—

— Step 3

Hover over a

g

e & e oeeee
I E R E R ENENENERDN]

component and RMB —
Place replicate create,
then RMB - DONE

Step 5

*® 299 =

s | _Josye D

® 299

*® 299

9 aa P

° o P

. nap pick ko zegment :::ext Step 4

. 3 Bt

: ® ® e Hover over a pin

s | [732 = "< and RMB - Snap
- pick to - Pin

Pop Dyn_Option_Select

Enter a name for the
Module Definition File
and Save

My Compul
‘ Fie name I_\E:.rn:l-:l v | [ Save ]
.‘g Ssveastpe | Modue Defintion File [ mdd) v| [ cance |
My et
[ Change Directery

EMA ‘ln\?li:m':atmn“



Design Reuse

® Place Replicate Unmatched Component Interface

P I a Ce m e nt Re pI i Cati O n Seed circuit -» Match: Similar components: Refdes (Device ;Yalus)
DoEs| ot Step 1
g | ves T o » _ e
Ig@ SRS URISE P Window - select
- P L targeted components Cr——
= LN ] [¥]value
Ig@ g b : : : UnEI\};ce companent Unmatch
= P:ace rep:icate crealte 4- St 2 [ ok ] [ Cancel | [ Hep |
— Flace replicate apply 3 S—
IQ@ = : : : : Add to group Browse. .. ep
“-3@ Joees e Selected components \
= LR ] .
IQ SR st okt a pin and RMB - Place Step 3
0 e » Highlight .
- ERS S replicate apply — P
- e N Unfiz H
IQ IS I module name Swap parts if
L — roperty edit
@|E| = Sth-\..l element need ed
Application Mode 4
super flter ’ see se e —_eeae see
Customize 4 F (“h o & ) o
o Ef:::ﬁ.::@‘ l:::::;::L
cos Bl el st <— Step4
see LX) e
. ol
.:::?::' ottt .
.o cee oo I, Place replicated
I KK s m X X L i I
ﬂ%oc :mccn;QEgco -ﬁoogé circuits
eee ™ eee .u‘—)h °
- o

ccccccccccccccccc
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Demo Time!

Adding Properties in OrCAD Capture

Assigning Differential Pairs in OrCAD Capture

Passing Properties from OrCAD Capture to PCB Editor
Placing Components in Rooms

Import Technology Files

Apply Differential Pair Constraints

Routing Differential Pairs

Routing Nets with Total Etch Length Constraints
Placement Replication

O I’C A D EMA ‘Rﬁi:naatmn“
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